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Release Notes 
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Notice Date: 2017-12-14 
 

 

This file lists all changes made to SAP2000 since the previous version. Most changes do not affect most users. 

Incidents marked with an asterisk (*) in the first column of the tables below are more significant. 

 

Changes from v19.2.2 (Released 2017-12-12) 

User Interface and Display 
Enhancements Implemented 

* Incident Description 

 202086 An enhancement has been implemented to keep the object assignment toolbars enabled when 

the model is unlocked, consistent with the corresponding menu items. 

 203261 An enhancement was implemented where the drop-down lists for point objects in the object 

connectivity form accessed from the right click form were modified to allow typing in the point 

name and were also modified to have the point names sorted alphabetically. 

Modeling 
Enhancements Implemented 

* Incident Description 

* 203387 An option has been added to control the limiting negative stiffness ratio for Frame Hinges. This 

option is available as a Hinge Overwrite for frame elements, under Assign > Frame > Hinge 

Overwrites in the menu. The limiting negative stiffness ratio defaults to 0.1, which is identical 

to previous versions of the program. This means that the descending slope is only 10% as stiff 

as the initial elastic stiffness. This ratio may now be increased up to 1.0. Using larger 

descending stiffness values increases the risk of elastic snap-back, which can cause 

convergence difficulties. Additionally, the Hinge Overwrites assignment form was enhanced to 

allow assignment of the Auto Subdivide and Hinge Behavior Parameters independently. 

Loading 
Enhancements Implemented 

* Incident Description 

* 207950 An enhancement was implemented to add automated seismic loading according to the IS 

1893:2016 code. 

* 207951 An enhancement was implemented to add automated seismic loading according to the ASCE 7-

16 code. 

* 207952 An enhancement was implemented to add automated seismic loading according to the Korean 

Building Code (KBC) 2016. 

* 207953 An enhancement was implemented to add automated response spectrum functions for the IS 

1893:2016 code. 

* 207954 An enhancement was implemented to add automated response spectrum functions for the 

ASCE 7-16 code. 

* 207955 An enhancement was implemented to add automated response spectrum functions for the 

Korean Building Code (KBC) 2016. 
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* Incident Description 

* 207956 An enhancement was implemented to add automated wind loading according to the ASCE 7-16 

code. 

* 207957 An enhancement was implemented to add automated wind loading according to the Korean 

Building Code (KBC) 2016. 

Analysis 
Enhancements Implemented 

* Incident Description 

* 43945 

96397 

An enhancement was implemented to account for effect of reinforcing steel on the axial creep 

and shrinkage behavior of concrete in columns and walls. The users can specify the rebar in 

individual columns and walls, or they can be taken from the most recent concrete frame or wall 

design. This enhancement only affects time-dependent staged-construction load cases. This 

formulation utilizes the steel reinforcement correction factor as described in "Creep and 

Shrinkage and the Design of Supertall Buildings - A Case Study: The Burj Dubai Tower" by 

W.F. Baker, D.S. Korista, L.C. Noval, J. Pawlikowski, and B. Young (2007), ACI Special 

Publications, 246. 

* 203151 An enhancement was implemented to add a pure event-to-event option for nonlinear static 

analysis, which can be particularly useful for static pushover analysis. This is similar to the 

pure event-to-event method available for nonlinear direct-integration time history analysis, and 

is in addition to the iterative event-to-event stepping strategy already available for nonlinear 

static load cases. Load steps will be automatically subdivided where changes occur in the 

stiffness of nonlinear elements. In contrast to the iterative method, more events will typically be 

generated, but iteration for equilibrium will not be performed under the assumption that the 

deviation from linearity will be small between events. Instead, any equilibrium errors are 

carried forward to the next load step and applied as a corrective load. This is similar to the 

method used in Perform-3D. This method may not be appropriate in cases with a large degree 

of geometric nonlinearity. Pure event-to-event stepping can be more efficient than iterative 

methods for small to medium sized models, but may not be so for large models with many 

nonlinear elements. Pure event-to-event stepping can also be helpful for models where 

convergence cannot be achieved with iterative methods, although the results should be 

reviewed for equilibrium. Additional minor changes have been made to the iterative methods 

used in nonlinear static and direct-integration time history load cases to improve convergence 

behavior. Results may change slightly compared to previous versions, but should be within the 

convergence tolerance for stable models.  

Frame Design 
Enhancements Implemented 

* Incident Description 

* 200697 An enhancement was implemented to add steel frame design according to the AISC 360-16 

code and the AISC 341-16 seismic provisions. 

Data Files 
Enhancements Implemented 

* Incident Description 

 103360 An enhancement was implemented to leave the case (upper or lower) of frame section property 

names as defined in the *.pro section property libraries when importing sections. Previously the 

name was changed to all capitals when imported. 
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Application Programming Interface 
Enhancements Implemented 

* Incident Description 

 201345 An enhancement was implemented, adding a new function to the API for each of the object 

types, which provides a way to retrieve the list of groups to which a specified object is 

assigned. The following API functions were added: PointObj.GetGroupAssign(), 

FrameObj.GetGroupAssign(), AreaObj.GetGroupAssign(), SolidObj.GetGroupAssign(), 

LinkObj.GetGroupAssign(), TendonObj.GetGroupAssign(), CableObj.GetGroupAssign(). 

Miscellaneous 
Enhancements Implemented 

* Incident Description 

 202890 The version number has been changed to v20.0.0 for a new major release. 

 

 

User Interface and Display 
Incidents Resolved 

* Incident Description 

 89156 An incident was resolved in which the Assign Frame Temperature Loads toolbar button 

incorrectly opened the Assign Frame Material Temperature form. This was a user interface 

issue only. 

 202150 An incident was resolved where applied frame loads were not displayed on screen for the 

element model. This was a display issue only. Loads were correctly displayed for the object 

model. 

 202775 An incident was resolved to correct the position of the Time Range Plotted label on the 

Material Property Time Dependence Plot form when only creep was selected to be considered. 

This was a user interface issue only and did not affect results. 

 203711 An incident was resolved in which a warning message was shown when displaying concrete 

shell design results for a model that contained any layered shell objects. Concrete shell design 

is not currently supported for layered shell objects and has now been disabled to eliminate the 

warning message. 

 204416 An incident was resolved in which a duplicate ordinate warning message was displayed when 

trying to add a gridline. This typically occurred when the current display units were different 

than the database units and the newly added gridline was close to an existing gridline. This was 

a user interface issue only and did not affect results. 

 204567 An incident was resolved on the replicate form for mirroring about a 3-D plane, where using 

the pick points capability did not populate coordinates for the third picked point. 

 204607 An incident was resolved for the interaction curve definition form for frame hinges in which the 

mouse over values shown on the Plot of Full Interaction Curve image were not presented 

correctly. This was only an issue on the form and did not affect analysis results. 

 206791 An incident was resolved where the Selection by Specifying a Coordinate Range feature did not 

work correctly when the current units were different from the model database units. 

Graphics 
Incidents Resolved 

* Incident Description 

 80641 An incident was resolved in which the extruded view of T-sections was incorrect when the 

mirror about 3-3 insertion point option was applied. This was a graphical issue only and did not 

affect results. 
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* Incident Description 

 202737 An incident was resolved where in DirectX graphics mode, if the fill was on for area objects 

some objects could appear unfilled if another object was added adjacent to it. This was a 

display problem only. GDI+ graphics mode worked as expected. 

 203291 An incident was resolved where selected objects could not be excluded from the model display 

in certain cases: (1) When displaying the deformed shape or other response quantities (stresses, 

forces, or moments) for a nonlinear static load case that continued from a previous nonlinear 

load case, all objects were being set to visible and none could be removed from the view; (2) 

When displaying the undeformed geometry using the Load Case Tree form, all objects were 

being reset to visible even though some of the objects might have been removed from the view 

before using the command Display > Show Load Case Tree. This was a display issue only and 

did not affect any analysis or design results. This issue affected the use of the View menu 

commands: Show Section Only, Invert View Selection, Remove Selection from View, and 

Restore Previous Selection to View. These commands are also available by right-clicking in the 

model window. 

Drafting 
Incidents Resolved 

* Incident Description 

 82992 An incident was resolved where in some instances when starting to draw new objects the snaps 

would not immediately be activated and a click was required to provide focus to the drawing 

form.  

 203861 An incident was resolved where drawing additional reference lines after a save operation or 

after 20 lines had already been drawn would delete the earlier drawn reference lines. 

 204444 An incident was resolved where the measure area tool would report an incorrect value if the 

current display units were different than the database units. 

 204561 An incident was resolved where using the previous selection command after replicating any 

points would select the replicated points in addition to the original points. 

Modeling 
Incidents Resolved 

* Incident Description 

* 203153 An incident was resolved where the deformation-type hysteresis parameters for types 

Degrading and BRB Hardening were specified as a ratio of yield for rigid-plastic frame hinges, 

which have no yield deformation. The affected parameters are "Moderate Deformation Level" 

and "Maximum Deformation Level" for Degrading hysteresis; "Maximum Plastic Deformation 

at Full Hardening" and "Accumulated Plastic Deformation at Full Hardening" for BRB 

Hardening hysteresis. These parameters have been revised to specify these deformations 

(displacements or rotations) normalized by the hinge deformation scale factors instead of yield 

deformation. This only affects models with frame hinges that use Degrading or BRB Hardening 

hysteresis and non-default hysteresis parameters. For affected models, please review the 

specified hysteresis parameters in the new version of the software. 

 203377 An incident was resolved where the analysis model was unable to be created when the model 

contained triangular area objects with area edge releases assigned. 

 203420 An incident was resolved where deletion of a Load Pattern that was used in a Mass Source 

definition could cause the scale factors for other load patterns in the mass source, occurring in 

the list after the deleted one, to change. 

* 203739 An incident was resolved to correct the following issues for the NZS 3101 time dependent 

properties: (1) The user-defined basic drying shrinkage strain is used directly for shrinkage 

computation and Eqn 8.14 in the documentation is removed. (2) The fc > 100 MPa condition 

for coefficient k5 is removed and Eqn. 8.6 in the documentation is corrected. 
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Section Designer 
Incidents Resolved 

* Incident Description 

 202223 An incident was resolved in the section designer DXF import where geometry was not imported 

if an aluminum or cold-formed steel material was selected for the SD Material on the import 

form. 

Analysis 
Incidents Resolved 

* Incident Description 

* 47671 An incident was resolved where the results of a moving-load load case may not have been 

correct for a vehicle having variable axle spacing and with the option "Vehicle Remains Fully 

in Path" selected. The results would be correct for an axle spacing within the specified range, 

but it may not have been the most critical spacing. This error did not affect fixed axle spacing, 

and it did not affect the most common, default case where the option "Vehicle Remains Fully in 

Path" was not selected. 

 203934 An incident was resolved in which the results for a steady state case were deleted when 

modifying a modal case while the model was locked, even if the modal case was not utilized by 

the steady state case. 

Frame Design 
Incidents Resolved 

* Incident Description 

 203960 An incident was resolved for steel frame design according to Norsok N-004 2013, where the 

default design preference values for gammaM0, gammaM1, and gammaM2 were not correct. 

Results Display and Output 
Incidents Resolved 

* Incident Description 

 75077 An incident was resolved where the axes plotted for the time-history graph that can be shown 

when creating animations (command File > Create Video) were not properly aligned with the 

graph itself, and the moving red dot did not properly track the time-history trace. These were 

display issues only and no results were affected. 

 85714 An incident was resolved in which changing the assigned interaction ratio color values would 

update the legend color in the display but not the color of the objects in the display. This was a 

graphical issue only and did not affect results. 

Data Files 
Incidents Resolved 

* Incident Description 

 98591 An incident was resolved where double-clicking a model file to open it could result in the 

filename being shortened to eight characters. 

Application Programming Interface 
Incidents Resolved 

* Incident Description 

 203128 An incident was resolved where the API function cPropLink.SetMultiLinearPoints would 

impose an input parameter restriction on force that was not consistent with the user interface. 
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External Import/Export 
Incidents Resolved 

* Incident Description 

 89028 

95987 

An incident was resolved for SAP2000 models with beams connected to walls that were 

exported to Perform-3D in which the generated Perform-3D model had embedded beams to 

transfer the bending moment from the beam to the wall, but a shear area of 0.001 was assigned 

causing unexpected Perform-3D results. 

 102890 An incident was resolved where rigid diaphragm specifications were not exported to Perform-

3D from SAP2000 if they contained joints with restraints for out of plane rotations. These are 

now allowed.   

 102987 An incident was resolved where in some cases the model exported from SAP2000 to Perform-

3D would generate an error in Perform-3D because there were no rebar materials defined in the 

original SAP2000 model. Now a rebar material is added, if none are present, when exporting 

models from SAP2000 to Perform-3D. 

 202151 An incident was resolved where a model could not be exported to a Perform-3D structure file if 

the model had null areas (area elements with section property "None"). This issue occurs only 

in models that also have area elements with a section property not set to None. 

 202153 An incident was resolved where the export from SAP2000 to Perform-3D would fail if 

trapezoidal frame sections were present in the model. Additionally, an issue was resolved where 

some frame sections (e.g. Steel Double Channel and Concrete Precast I-sections) were not 

correctly exported and the SAP2000 frame objects with these frame sections assigned would 

not be exported to the Perform-3D model. 

Documentation 
Incidents Resolved 

* Incident Description 

 101637 The help topic Draw Solid has been removed as the command Draw > Draw Solid does not 

exist. 

 200506 An incident was resolved where the SAP2000 API CHM help Python example would report an 

AttributeError if a certain version of the Python package "comtypes" was installed. The API 

example has been updated to include the correct package version. 

 


